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Welcome to Cascadia Consulting Group’s Climate Impacts 

Decision-Support Tool (also known as CIMPACT-DST)!  

This tool guide will help you understand and use the tool so that you can 

realize its full potential. 

GUIDE OVERVIEW 

This guide is organized into four sections. It begins with a Quick Start Guide that lists basic, key steps for using the tool. We recommend 

beginning with the Quick Start Guide, and then if you have questions, consulting the remainder of this document. The next sec tion, Tool 

Overview, provides an overview of the tool, including its underlying conceptual and structural framework. The Tool Overview section 

establishes a solid foundation for understanding the individual sections of the tool. The following two sections—Getting Started and 

Using the Tool: A Step-by-Step Guide—discuss detailed steps for preparing for and using the tool.  

1 QUICK START GUIDE Basic Steps for using the tool 

2 TOOL OVERVIEW Introduction to the tool’s conceptual and structural framework. 

3 GETTING STARTED Checklist to prepare for best use of the tool 

4 THE TOOL: STEP-BY-STEP Detailed instructions on how to use the tool 
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By the end of this guide, you should have the 

knowledge and capacity to: 

 Discern situations in which CIMPACT-DST should be used. 

 Identify and gather needed information. 

 Navigate and complete the tool’s required inputs. 

 Understand and use the tool’s outputs. 

 

To make this guide as useful as possible, we 

suggest that you consider the following tips: 

 Go in order.  

Because the tool is organized into sequential stages or “tabs,” 

we recommend that you follow this guide in order, from start 

to finish. Skipping to different sections could be confusing.  

 Follow alongside.  

This guide references specific items in the tool quite often. 

Follow along with the tool open on your computer, rather 

than relying on the screen shots included in this document. 

 Look for hints embedded in the tool.  

There are many hints and tips embedded inside the tool itself. 

If anything seems confusing, try experimenting with the tool to 

see if it helps. Click on the “Help” buttons (    ) to provide 

useful information within the tool. 

We have provided a number of easy-reference icons and sections 

to help you identify useful information throughout this guide: 

   

 
CAUTION! 

Indicates important 
information to ensure tool 

functionality or usefulness. 

   

 
TIP! 

Indicates tips, hints, and 

tricks for using and 

understanding the tool. 

   

 
CHECKLIST 

Indicates items that will be 
needed for the tool’s inputs. 

   

 
EXAMPLE 

Indicates an example 

scenario. 
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1 QUICK START GUIDE 

Below are basic instructions for using the tool. For more information, consult the relevant sections of this document. 
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2 TOOL OVERVIEW 

This section provides an overview of the tool’s conceptual and 

structural framework to help you navigate and understand the 

sections of the tool. 

What is CIMPACT-DST? 

CIMPACT-DST is an Excel-based tool that helps local 

governments and planning agencies incorporate climate change 

impacts into their jurisdictions’ planning and operations.  

Once customized for the jurisdiction, local government staff and 

planners use the tool to identify and consider climate change 

impacts and adaptation options in their decision-making. Climate 

scientists call this process “mainstreaming.” 

By using CIMPACT-DST, government staff members across 

sectors and departments can see policies, plans, regulations, and 

projects through a “climate lens” (see figure below). Consistent 

application of this lens across City departments will slowly build 

system-wide resilience to climate change within the jurisdiction. 

Adapted from the OECD Policy Guidance on Integrating Climate 

Change Adaptation into Development Co-operation (Organization 

for Economic Cooperation and Development (OECD). (2009).  

 

Figure 1. Users of CIMPACT-DST will begin to view policies, 

plans, regulations, and projects through a “climate lens.” 
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How is CIMPACT-DST Different? 

The tool works by compiling multiple sources of locally-relevant 

information—including reports, policies, and maps—and filtering it 

based on simple user inputs. This way, the user sees only 

information that is relevant and useful for the task at hand. 

Contrast this to the alternative: wading through a 100-page 

guidance or policy document in search of pertinent information. 

CIMPACT-DST is quick, simple, and practical. 

CAUTION! Please note that CIMPACT-DST is an 

informational—not analytical—tool. It does not conduct cost-

benefit or feasibility analysis or compare alternatives. For such 

analyses, there are a variety of other tools available such as 

those described in GIZ’s 2013 publication, Economic Approaches 

for Assessing Climate Change Adaptation Options Under 

Uncertainty.   

 

Conceptual Design 

CIMPACT-DST synthesizes, simplifies, and integrates different 

types of climate-related information from various sources. 

Information that is already built into the tool, listed in Figure 2 

below, includes the following: 

 Projected primary climate impacts from the latest climate 

modeling and science 

 Local spatial analyses of projected climate hazards, exposures, 

and risks 

 Reports on projected sector-specific secondary impacts and 

good practices for building resilience to those impacts 

 Guidance from local, state/provincial, and national 

stakeholders, regulations, and policies  

Figure 2. Information sources for CIMPACT-DST 
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The tool integrates the built-in information listed above with user-specified project inputs to provide project-specific impact 

summaries and guidance. The sectors and jurisdictions included in the national Vietnam CIMPACT-DST are listed below: 

Figure 3. Project sectors 

and locations included in the 

Vietnam CIMPACT-DST 
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Information on climate projections, hazards, and sector-specific impacts and guidelines are embedded in the tool. When users add 

information on their project’s sector, lifespan, and location, the tool produces output information. Output information includes bullet-

point summaries of primary climate impact projections, secondary sector-specific impacts, and sector-specific guidelines and 

recommendations. You can think of these outputs as summaries of the problem (how climate change will affect your project) and the 

solution (what you can do about it). The figure below illustrates how user inputs and information programmed into the tool result in 

tool outputs. 

Figure 4. CIMPACT-DST 

information processing 

and outputs (circled items 

in blue indicate user inputs) 
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Tool Updates 

The information embedded in the tool is not permanent. The tool 

can be easily updated as new climate information, policies, and 

analyses are available. It is the responsibility of a local Tool 

Administrator to periodically update the tool with this new 

information. If you have questions about the tool’s content or 

would like to submit additions or revisions, please contact your 

local Tool Administrator. 

Tool Format and Layout 

Software and Restrictions 

CIMPACT-DST is hosted in Microsoft Excel. The tool has 

macros—pieces of programming that help automate the tool— 

that render the tool only compatible with Microsoft Excel 

versions 2010 or higher. To use the tool, you must enable macros 

(see note below). 

CAUTION! You must have Excel 2010 or a more recent version 

to use CIMPACT-DST. To determine your version of Excel, go to 

the “Help” menu and then click on “About Microsoft Excel.” If 

you do not see this option in the menu, you are probably using 

Excel 2010 or higher.  
 

CAUTION! You must enable macros to use CIMPACT-DST. 

When you open the tool in Excel, you may see a yellow ribbon 

across the top that looks like the following:  
 

 
 

To use the tool, you must select “Enable Content.” This will 

enable you to use all of the features of the tool. 
 

Tool Roadmap 

The tool is organized into input and output tabs. Each output tab 

is organized by the type of climate impact (temperature, 

precipitation, and sea level rise). The user consults climate impact 

maps to identify project hazard zones. The hazard zones of a 

project inform the content and language of the output tabs. Three 

reference tabs provide further information on the tool’s 

information sources and underlying logic. 

 

Figure 5. The sections, or tabs, of the Vietnam CIMPACT-DST  



9 

How It Works 

There are a variety of protected and hidden elements in 

CIMPACT-DST that the user cannot see or edit. Hidden tabs hold 

embedded information and dropdown lists, hidden programming 

codes help automate the tool, and protected text helps avoid 

accidental editing. These elements are protected and hidden to 

make the tool simpler and easier to use.  

CAUTION! Do not attempt to view or change hidden or 

protected elements of the tool. Doing so may irreversibly 

compromise tool functionality. 

Saving the Tool 

The tool’s inputs and outputs will likely be different each time you 

use it for a different project. You may encounter a scenario in 

which you would like to save these specific inputs and outputs. To 

do so, the tool functions like any other Excel file. If you save the 

file as a specific name, such as “CIMPACT-DST Bridge Project A.xlsm,” 

you will see those same inputs and outputs next time you open 

the file. We recommend that you save the tool as a separate file 

every time it contains information that you would like to 

remember or share with colleagues. When saving, be sure to save 

as an “Excel Macro-Enabled Workbook” (.xlsm). 

CAUTION! Always save the tool as an “Excel Macro-Enabled 

Workbook (.xlsm).” Failure to do so will compromise tool 

functionality. The picture below shows how to select this 

option from the dropdown menu when using the “Save As” 

command in Excel. 
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3 GETTING STARTED 

This section details steps that should be completed before 

opening the tool. 

 

Step 1: Determine what you need 

Because the tool supplies information for only a limited number of 

sectors, it is first important to identify whether the tool contains 

the information you need. For example, the tool supplies 

information on urban-focused sectors such as urban land use 

planning, transportation planning, and water supply, but this 

version does not supply information for rural-focused sectors 

such as agriculture or aquaculture.  

EXAMPLE SCENARIO. John checks the list of sectors 

included in the tool and identifies that his Town Center project 

fits under the “Infrastructure Planning” sector of the tool. Step 

1 is complete! 

Step 2: Be prepared 

To use the tool successfully, you will need to gather the following 

information about your project: 

- Project name 

- Project location 

- Project sector 

- Project lifespan (design life) 

EXAMPLE SCENARIO. John’s project is named “Town 

Center”; it is located on 112 Main Street; and it has a design 

life of 50 years.  

Step 3: Plan for use 

The tool’s outputs are only as valuable as how you or others will 

use them. Before using the tool, develop a clear plan for what you 

will do with the tool’s outputs once you obtain them. This 

includes addressing how you will you store, organize, and share 

the information. 

EXAMPLE SCENARIO. John will share the outputs of the 

tool with his design team and consider them in project 

brainstorming meetings. 

 

 

The Example Scenario 

 

Throughout the remainder of the guide, we will provide 

an example scenario to help you understand the tool’s 

practical application. In the example scenario, John is a 

city planner at the City’s Urban Planning Institute who is 

hoping to update a popular tourist city building, called 

Town Center, to give it a more modern look. He is using 

CIMPACT-DST to explore ways in which he can build his 

city’s resilience to climate change through more informed 

design and development of the project. 
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This section introduces the steps to using the tool, tab by tab. Each step has the following components: 

- Roadmap: a screenshot of the tool tab 

- Overview/purpose: information the tab uses or provides and how it fits into the overall process 

- Checklist: information the user will need to complete the tab 

- Step-by-step guidance: steps that detail the user options, how to decide which to choose, and the implications of 

each option for tool outputs 

 

The Basics: Tool Navigation and Guidance 

The tool progresses tab-by-tab in the following order: 

 

Navigation buttons, such as depicted below, are provided throughout the tool  to guide users through the tabs.  

 

 

 

 

Note that you can also click on the tabs at the bottom of the Excel sheet to navigate between tabs: 

 

 

 

Project Type Temperature
Project

Exposure Climate DataSea Level Rise ReferencesPrecipitation
Potential

Exposure

4 USING THE TOOL: A STEP-BY-STEP GUIDE 
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TIP! Help icons, indicated by question marks (      ), are located throughout the 

tool to provide guidance. Simply click on the question marks to reveal or hide 

helpful information:  

 

The upper right of every tab has a series of modification buttons that provide a quick way to modify views and user inputs.  

 

The “Excel Ribbon” refers to the belt of options and selection items across the top of the Excel interface (see below). Hiding the Excel 

Ribbon enables users to more easily view the tool. 

 

CAUTION! The Erase Inputs button is irreversible. The eraser button will permanently remove user-entered information in the tool. This action 

cannot be undone. Be careful before clicking this button! 
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Saving and Printing 

You can save the tool by selecting “View Excel Ribbon” ( ) and selecting “Save As” from the “File” menu. Be sure to save as an “Excel 

Macro-Enabled Workbook (*.xlsm). You can also use this approach to print the tool outputs (Select “Print” from the “File” menu) . 

  

 

You can also simply click the “save” and “print” buttons on the navigation pane:  
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TAB 1: PROJECT TYPE 

The “Project Type” tab is the first tab you will see on CIMPACT-DST.  
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Overview/Purpose 

The “Project Type” tab has a series of basic informational inputs 

that describe the project and provide the basis for specific 

temporal and spatial information later in the tool. The Project 

Type tab also introduces the tool, its requirements, and the 

primary climate change impacts that the tool addresses. 

CHECKLIST. To complete this tab, you must have the 

following information ready: 

- Project name 

- Project planning type 

- Project sector 

- Project location 

 

Step-by-Step Guidance 

TIP! Be Patient! When choosing items from the dropdown 

menu, the software may take some time to update. Be patient 

and wait until the cross cursor is apparent (      ) before 

selecting the next cell. 

1: Project Name  

This field is for informational purposes only. Enter whatever name 

makes sense to you so that you and your colleagues can 

remember and recognize it later.  

EXAMPLE SCENARIO. John enters “Town Center” as the 

Project Name. 

2: Planning Type 

This is a REQUIRED field that indicates the scope of planning that 

the project entails. To complete this field, choose one of four 

options: Regional, General, Detailed/Zoning, or Specialized 

Technical Infrastructure Planning. 

EXAMPLE SCENARIO. John selects “Detailed/Zoning 

Planning” as the planning type. 

3: Sector 

This is a REQUIRED field that indicates the sector of the project. 

This input will inform the kind of impact and guidance information 

you receive on the output tabs of the tool. To complete this field, 

choose among the specified options. If your sector is not listed, 

consult the Tool Administrator or choose the best fit.  

EXAMPLE SCENARIO. John selects “Urban Design” as the 

sector type. 

4: Province/Centrally-Controlled City 

This is a REQUIRED field that indicates the province or centrally-

controlled city of the planning project. 

EXAMPLE SCENARIO. John selects “Can Tho” as the 

province/centrally-controlled city. 

5: City/Town/District  

This is an OPTIONAL field that indicates the city, town, or 

district of the project. This input will only appear if the planning 

type is detailed/zoning planning.  

EXAMPLE SCENARIO. John selects “Bình Thủy” as the 

city/town/district. 
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TAB 2: PROJECT EXPOSURE 

The “Project Exposure” tab is the second tab of CIMPACT-DST. This is the second and final tab in which the user enters information 

about the project.  



 

17 

Overview/Purpose 

Because climate impacts will vary across time and landscapes, the 

tool requires spatial and temporal information about the project. 

This section allows the tool to provide more precise climate 

impact and guidance information. 

To complete this tab, the user must consult project design 

specifications to specify the project lifespan and view maps to 

determine the extent to which the project is located in “hazard 

zones.”  

CHECKLIST. To complete this tab, you must have the 

following information ready: 

- Project lifespan 

- Project location 

 

Step-by-Step Guidance 

1: Expected Lifespan of Project  

This field can be interpreted as the design life of a project. The 

project lifespan is important because projects with longer lifespans 

will need to withstand more severe climate impacts. If you want 

the project to survive up to 2050, for example, you would have to 

design the project to withstand the projected impacts in 2050—

such as a 1oC increase in temperature. If that same project was 

designed to survive only until 2030, then the project would only 

need to withstand the projected impacts in 2030, which could be 

something like a 0.5oC increase in temperature. The impact 

summaries in the tool would therefore reflect these differences.  

TIP! What if my project lifespan is not an option?  If the 

specified lifespan of your project is not one of the pre-set 

options, then choose the next highest available lifespan. For 

example, if your lifespan is 2040, choose 2050. This provides a 

conservative estimate that will serve to minimize the risk of 

potential climate change impacts to your project. 

EXAMPLE SCENARIO. John’s Town Center project will be 

designed to last up to 2040. Because 2040 is not an option in 

the tool, John will select to next highest lifespan:  “up to 

2050.”  

 

2: Hazard Zones 

The remaining fields are for indicating the hazard zone within 

which your project is located. There are eight potential hazard 

zone maps in the Vietnam CIMPACT-DST: 

1. Temperature Exposure Map 

2. Rainfall Exposure Map 

3. Drought Exposure Map 

4. Flood Exposure Map 

5. Landslide Exposure Map 

6. Sea Level Rise Inundation Exposure Map 

7. Coastal Erosion Exposure Map 

8. Salinity Intrusion Exposure Map 

All of the above hazard zone maps are associated with a 

dropdown menu. The maps are located online and can be 

accessed using the icon buttons beside the dropdown menu. 
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The zones represent increasing levels of potential exposure or 

sensitivity to specific climate change impacts. For example, low-

lying projects closer to the river are more likely to be exposed to 

increased flooding than inland projects. The hazard zone you 

select informs the severity and urgency of the impact descriptions 

and guidance information. This feature allows users to fully 

understand the risks and potential consequences associated with a 

project’s proposed location.  

To identify which hazard zone your projected is located, click on 

icon next to the dropdown menu. This leads you to a website 

where you can find the location of your project and the hazard 

zone associated with that location.  

Step-by-step Instructions for Identifying Your 

Project Hazard Zones 

These instructions are for identifying your project Temperature 

Exposure (the menu below). The same procedure can also be used 

for the other maps. Note that you must have Internet Explorer to 

view the maps. 

  

1. First, click on the Temperature Exposure icon (  ). This will 

bring you to the “Temperature Exposure” map on your Internet 

Explorer browser. Note how zones are delineated: different 

colors represent different zones. 

2. Next, use the “zoom” tools to zoom into your project area. 

3. Note which temperature zone your project is located within 

using the map’s legend. Click back to Excel. 

4. Choose your project's temperature exposure zone from the 

dropdown menu. 

TIP! What if my project overlaps zones? If your project 

straddles two or more zones, choose the zone with the higher 

hazard. For example, if your project straddles the “2.5-3.0 

degrees C” and “3.1-3.5 degrees C” zones then choose the 

“3.1-3.5 degrees C” zone. This provides a conservative 

estimate that accounts for the highest potential level of risk to 

your project. 

TIP! What if there is more than one map? In some 

instances, you may be directed an interface with more than one 

map. In this case, choose the highest climate impact zone 

among the maps for your project area. 

TIP! What if the zone is unclear due to low-resolution 

spatial information? Some maps, such as the national 

temperature exposure map, are lower resolution and may be 

difficult to discern at smaller scales. If your project area lies on 

a border or otherwise undiscernible area, choose the hazard 

zone for the closest discernable area to your project. 

If Maps are Unavailable 

If a map is not available for your area, choose the future (or, if not 

known, current) zone of your planning area to the best of your 

ability using local knowledge or available studies. 
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Temperature Exposure 
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TABS 3, 4, AND 5: TEMPERATURE, SEA LEVEL RISE, AND PRECIPITATION 

The Temperature, Sea Level Rise, and Precipitation tabs are the output tabs of the tool. 
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Overview/Purpose 

These three tabs are identical in structure and provide quantitative and qualitative summaries of climate change impacts and guidance for 

mitigating those impacts. Note that the outputs on these tabs are project-specific and dependent upon the project lifespan and location 

parameters entered on the “Project Exposure” tab. 

CHECKLIST. No information needed 

 

Step-by-Step Guidance 

1: Projected Impacts and Exposure 

The Project Impacts and Exposure sections provide quantitative province-specific climate impact information. 

Projected Range of Impact. The projected range of impact summarizes the latest climate models for the time period of interest for 

the province. This information can help you understand the range of temperature, precipitation, and sea levels to expect and plan for 

over the lifetime of your project. 

EXAMPLE SCENARIO. John found that the Town Center will be exposed to the following projected range of impacts. He will use this to 

inform his design team that all infrastructure materials must have the capacity to withstand this new range of temperatures. 
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Potential Exposure. Potential exposure summarizes the risk of your project to climate change impacts as a function of its lifespan and 

location within the hazard maps. For projects with a long planning horizon and located within high-risk hazard zones, for example, the 

tool will indicate a HIGH potential exposure for the project and provide a brief explanation of what that  potential means for your 

project. This relationship is shown in the figure below. 

 

 

EXAMPLE SCENARIO. John found that the Town Center has a LOW potential exposure to increased temperature stress. He will use this 

information to ensure that the Town Center features adequate “shaded retreat” areas to relieve visitors during extreme heat events.  Because 

he is located within a low urban heat island zone with moderately vulnerable populations, he likely will not take more costly action to combat 

higher temperatures, such as the installation of expensive new air conditioning systems. 
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2: Impact Summary  

The Impact Summary section is where you will find sector-specific qualitative summaries of climate change impacts you should expect to 

occur for your type of project. You should consider these impacts when making decisions about your project. 

Underlined Impact Summary statements indicate a link to the statement’s source document. Click once on an underlined statement to 

navigate to that specific page of the reference document on Internet Explorer.  

TIP! Think of the Impact Summary (and Guidance Information) as a checklist. The Impact Summaries can sometimes lead to more 

questions than answers. For example, the impact may indicate that “higher temperatures may change material performance.” This may lead you 

to ask, “Which materials will change, and how will they change?” The tool  does not provide answers to these questions; it can, however, bring 

this issue to your attention and allow you to consult the material or design experts on your team for more information. In this way, you can 

think of the Impact Overview as an informal checklist of key issues to consider. Review each item and make note as it is considered. Not all 

impacts will call for changes in project design or decisions, and that is acceptable. As long as you are aware of the issue and have considered it 

in the development of your project, you have used the tool correctly. 

EXAMPLE SCENARIO. John found that the Town Center may incur the following temperature impacts from climate change. He will use this 

information to estimate visitation rates for different areas (e.g., shaded vs. exposed)  of the Town Center. 
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3: Guidance Information 

The Guidance Information sections provide recommendations and suggestions for taking action to address and build resilience i n your 

project to climate change impacts. The guidance, which includes information related to the physical system of your project, people or 

communities that may be affected, and the project’s underlying institutions, propose ways to ensure that your project “stands  the test of 

time.”  Like the Impact Summary section, you do not necessarily need to take action on all listed recommendations. Instead, think of this 

section as a checklist of actions to consider and evaluate further.  

Underlined Guidance statements indicate a link to the statement’s source document. Click once on an underlined statement to navigate 

to that specific page of the reference document on Internet Explorer. 

 

EXAMPLE SCENARIO. John received the following guidance information from the tool. He will consider these recommendations and ask his 

design team to incorporate twice as many trees as usual in the design of the Town Center.  
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TAB 6: REFERENCES 

“References” is the first of three tabs that provide further information on the tool’s underlying information sources and log ic.
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Overview/Purpose 

The “References” tab is intended for informational purposes 

only. It contains full citations and links to all of the information 

sources referenced in the Impacts Summary and Guidance 

Information sections of the tool.  

CHECKLIST. No information needed.  

 

Step-by-Step Guidance 

1: Reference Number 

Every Impacts Summary and Guidance Information statement in 

the tool is followed by a number in brackets (e.g., [4]). This 

number represents the information source for that statement.  

Underlined numbers contain hyperlinks to the location of that 

information source on the internet. Click once on the number to 

direct your internet browser to an online version of the 

document (see figure below).  

 

 

 

4: Full Citation 

This field is the full citation of the information source. 
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TAB 7: CLIMATE DATA 

 

Overview/Purpose 

Like the “References” tab, the “Climate Data” tab is intended for informational purposes only. It elaborates on the climate projection 

data presented in the “Projected Range of Impact” sections of the tool. The page explains the climate projection data that are available 

for Vietnam and their assumptions and specifications. 

CHECKLIST. No information needed 
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TAB 8: POTENTIAL EXPOSURE 

 

Overview/Purpose 

Like the “Climate Data” tab, the “Potential Exposure” tab is intended for informational purposes only. It elaborates on the statements 

presented in the “Projected Impacts and Exposure” sections of the output tabs of tool. The page explains how the Potential Exposure 

statements are generated from user-specified inputs. 

CHECKLIST. No information needed 

 

 



 

29 

Questions? 

If you have questions, encounter difficulties using the tool, or have encountered an error in the tool’s functio ning, content, or structure, 

please contact Dr. Luu Duc Minh of VIUP at: 

luuducminhjp@gmail.com 

He will respond to your inquiry as soon as possible. 

  

mailto:andream@cascadiaconsulting.com
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